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   ABSTRAK 

 

Sering terjadi penjadwalan ulang proyek disebabkan beberapa faktor seperti 

keinginan pemilik proyek, Kekurangan  tenaga  kerja, dana, waktu dan cuaca. Dalam 

skripsi ini penjadwalan ulang proyek dikarenakan keinginan pemilik proyek untuk 

mengoptimalkan proyek dan memperoleh hasil yang efisien.  Penjadwalan ulang ini 

dilakukan menggunakan program komputer microsoft project  untuk mendapat kan 

hasil yang lebih efisien dan efektif, Dengan durasi yang optimal. Dalam penjadwalan 

proyek ini menggunakan metode jaringan kerja PDM (precedence diagram method)  

metode  dengan satu garis dari pekerjaan terdahulu ke pekerjaan berikutnya satu  

konstrain hanya dapat menghubungkan dua pekerjaan. karena setiap node memiliki 

dua ujung awal (S) dan akhir (F) maka ada empat macam konstrain. SS, SF, FS, FF. 

 Dengan penjadwalan kembali proyek ini menggunakan metode PDM pada microsoft 

project dan penambahan sumber daya, maka di dapat hasil durasi lebih optimal, 

biaya langsung bertambah dan biaya tidak langsung berkurang. Dengan hasil sebagai 

beikut optimasi biaya sebesar Rp. 40.987.500 optimasi waktu sebanyak 15 hari 

dengan total biaya awal proyek sebesar Rp 1.757.551.500,- setelah penjadwalan 

ulang berkurang menjadi sebesar Rp 1.716.569.000,-.   

 

 

Kata Kunci : Proyek konstruksi, microsoft project, metode PDM, Optimal 
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ABSTRACT 

 

Often rescheduling occurs due to factors such as project owner desires, labor 

shortages, funds, time and weather. In this thesis project rescheduling is due to the 

project owner's desire to optimize the project and obtain efficient results. 

      This rescheduling is done using a microsoft project computer program to get 

more efficient and effective results, with optimal duration. 

      In the scheduling of this project using the PDM network method (precedence 

diagram method) method with a line from previous work to the next job one 

constraint can only connect two jobs. 

      Since each node has two initial ends (S) and end (F) then there are four kinds of 

constraints. SS, SF, FS, FF. With the rescheduling of this project using the PDM 

method on microsoft project and the addition of resources, then in the results can be 

more optimal duration, direct costs increase and indirect costs are reduced. 

 

Key word: Construction project, Controlling, Earned value analysis, optimal 
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BAB I 

PENDAHULUAN 

1.1. Latar Belakang 

 Proyek dapat diartikan sebagai kegiatan yang berlangsung dalam jangka waktu yang 

terbatas dengan mengalokasikan sumber daya tertentu dan dimaksudkan untuk menghasilkan 

produk atau deliverable yang kriteria mutunya telah digariskan dengan jelas. Semakin maju 

peradaban manusia, semakin besar dan kompleks proyek yang dikerjakan dengan melibatkan 

penggunaan bahan-bahan (material), tenaga kerja, dan teknologi yang makin canggih. Proyek 

pada umumnya memiliki batas waktu (deadline), artinya proyek harus diselesaikan sebelum 

atau tepat pada waktu yang telah ditentukan. Berkaitan dengan masalah proyek ini maka 

keberhasilan pelaksanaan sebuah proyek tepat pada waktunya merupakan tujuan yang penting 

baik bagi pemilik proyek maupun kontraktor. 

 Demi kelancaran jalannya sebuah proyek dibutuhkan manajemen yang akan 

mengelola proyek dari awal hingga proyek berakhir, yakni manajemen proyek. Bidang 

manajemen proyek tumbuh dan berkembang karena adanya kebutuhan dalam dunia industri 

modern untuk mengkoordinasi dan mengendalikan berbagai kegiatan yang semakin 

kompleks. Manajemen proyek mempunyai sifat istimewa, dimana waktu kerja manajemen 

dibatasi oleh jadwal yang telah ditentukan (Hartawan, n.d). Perubahan kondisi yang begitu 

cepat menuntut setiap pimpinan yang terlibat dalam proyek untuk dapat mengantisipasi 

keadaan, serta menyusun bentuk tindakan yang diperlukan. Hal ini dapat dilakukan bila ada 

konsep perencanaan yang matang dan didasarkan pada data, informasi, kemampuan, dan 

pengalaman. 

Keberhasilan ataupun kegagalan dari pelaksanaan seringkali disebabkan kurang terencananya 

kegiatan proyek serta pengendalian yang kurang efektif. Sehingga kegiatan proyek tidak 

efisien, hal ini akan mengakibatkan keterlambatan, menurunnya kualitas pekerjaan, dan 
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memperbesar biaya pelaksanaan. Keterlambatan penyelesaian proyek sendiri  adalah kondisi 

yang sangat tidak dikehendaki. 

 Perusahaan seringkali mendapatkan masalah dalam waktu penyelesaian proyek karena 

waktu penyelesaian tidak sesuai dengan waktu yang telah disepakati sebelumnya. Hal ini 

akan berdampak buruk bagi perusahaan, diantaranya memperburuk image, dimana 

perusahaan yang berkesan tidak mampu menyelesaikan proyek sesuai dengan kontrak yang 

telah disepakati. Dalam suatu kondisi pemilik proyek bisa saja menginginkan proyek selesai 

lebih awal dari rencana semula, tapi karena faktor eksternal seperti misalnya faktor cuaca, 

proyek memiliki perkembangan yang buruk sehingga implementasi proyek tidak seperti yang 

direncanakan, atau dapat dikatakan kemajuan proyek lebih lambat.  Untuk mengembalikan 

tingkat kemajuan proyek ke rencana semula, diperlukan suatu upaya percepatan pelaksanaan 

proyek walaupun akan diikuti meningkatnya biaya proyek. Oleh karena itu diperlukan 

analisis optimalisasi proyek sehingga dapat diketahui berapa lama suatu proyek tersebut 

diselesaikan dan mencari adanya kemungkinan percepatan waktu pelaksanaan proyek dengan 

microsoft projeck 2007.  

Microsoft Project 2007 merupakan sebuah program komputer yang ditujukan untuk  

manajemen proyek, dimana pengoperasiaannya maupun tukar-menukar data dengan  

program office lain dapat dilakukan dengan mudah. Oleh karena itu, pada penelitian  

ini analisis konsep nilai hasil akan dilakukan dengan menggunakan program  

Microsoft Project 2007 

 

 

 

1.2. Maksud dan Tujuan  
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 Maksud dari penelitian ini adalah penjadwalan ulang pekerjaan dengan membuat 

jaringan kerja berbasis microsoft project tujuan untuk menghasilkan waktu an biaya yang 

optimal. 

1.3  Rumusan Masalah 

Berdasarkan uraian latar belakang di atas, maka diambil rumusan masalah yaitu Berapa 

besarnya biaya yang telah dikeluarkan untuk pelaksanaan proyek ini.  Dan Berapa prakiraan 

besarnya total biaya dan waktu untuk penyelesaian proyek 

1.4 Batasan Masalah  

Adapun batasan masalah dari penelitian ini antara lain. Menentukan jaringan kerja atau 

network proyek dengan micrososft project, Menganalisis waktu yang optimal untuk 

menyelesaikan proyek,  Menganalisis perkiraan biaya untuk proyek Menjadwalkan ulang 

proyek (reschedulling)   

1.5. Manfaat Penelitian   

Manfaat yang diharapkan dapat diambil dari penelitian ini adalah, Menambah pengetahuan 

penggunaan program Microsoft Project 2007 untuk analisis konsep nilai hasi, Menambah 

pengetahuan bahwa perencanaan biaya dan jadwal yang akurat dalam  proyek akan 

bermanfaat dalam menentukan keberhasilan proyek, Menambah pemahaman dalam membaca 

laporan kemajuan proyek, Dapat digunakan sebagai bahan referensi perhitungan kemajuan 

proyek pada  proyek lain yang sejenis 

 

 

 

.          

 

1.6  Tahap dan Alur Penelitian   
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Suatu penelitian harus dilaksanakan secara sistematis dan dengan urutan yang jelas  

dan teratur, sehingga akan diperoleh hasil sesuai dengan yang diharapkan. Oleh  

karena itu, pelaksanaan penelitian ini dibagi dalam beberapa tahap, yaitu :   

a.  Tahap I (mulai )  

pada tahap ini dilakukan persiapan mental dan data2 adnimistratif sebagai pendukung akan 

berjalannya skripsi ini sesuai dengan rencana sehingga tidak terkendala dengan faktor 

eksternal dari skripsi itu sendiri  

b. Tahap II (masalah)  

tahap ini dilakukan bagaimana cara menghasilkan optimasi biaya dan waktu dalam 

penjadwalan ulanng suatu proyek. dilakukan hal-hal sebagai berikut: Observasi lapangan dan 

identifikasi proyek yang akan diteliti  Melakukan proses peizinan kepada pelaksana atau 

pemilik proyek  

c.  Tahap III (persiapan ) 

Tahap persiapan dilakukan dengan cara melakukan studi literatur dengan  

membaca buku materi kuliah, jurnal, dan referensi yang berhubungan dengan  

pembuatan laporan penelitian 

Pada tahap ini dilakukan pengumpulan data proyek yang diperlukan untuk  

pembuatan laporan, meliputi:  Rencana Anggaran Biaya (RAB), Daftar harga satuan bahan, 

alat dan upah tenaga kerja, Time schedule atau kurva S ,  Laporan mingguan yang berisi 

kemajuan proyek,  Daftar penggunaan bahan, alat dan tenaga kerja per harinya Tahap IV 

(tahap analisis data dan pembahasan) Pada tahap ini data yang diperoleh dari proyek 

dianalisis dengan bantuan program Microsoft Project 2007 dan dilakukan pembahasan 

sehingga diperoleh hasil yang mengarah pada tujuan penelitian.  

d. Tahap IV (penentuan objek penelitian)  
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pada tahap ini dilakukan Observasi lapangan dan identifikasi proyek yang akan diteliti  

Melakukan proses peizinan kepada pelaksana atau pemilik proyek sehingga memudah kan 

dalam pengambilan data proyek yang akurat dan ada kenyamanan saat melakukan penelitian 

pada proyek tersebut. 

e. Tahap V (pengumpulan data) 

pada tahap ini dilakukan pengumpulan data dari lapangan maupun dari data kuantitatif dari 

pimpinan proyek yang langsung memegang data kelola proyek. Data yang dapata di ambil 

seperti RAB, harga satuan bahan dan upah, rencana dan raealisasi dari proyek tersebut. 

f. Tahap VI (analisis dan pembahasan)  

pada tahap ini dilakukan penjwadalan ulang dari jadwal awal proyek menggunakan dua 

metode yaitu dengan metode SNI dan metode PDM pada program microsoft project. Dengan 

pertimbangan sebagai optimasi adalah biaya tidak langsung proyek dan dalam hal ini biaya 

langsung adalah relatif.  

g. Tahap VII  (kesimpulan) 

Pada tahap ini, data yang telah dianalisis kemudian dibuat suatu kesimpulan yang  

berhubungan dengan tujuan penelitian Dari perhitungan kompresi terhadap jaringan kerja 

pada pembangunan proyek perumahan SEI SUKA RESIDENCE BATUBARA, maka dapat 

diambil kesimpulan yaitu. Setelah melakukan penjadwalan ulang pada durasi kegiatan normal 

proyek, maka  diketahui durasi kegiatan normal 100 hari menjadi 85 hari dengan penurunan 

biaya sebesar Rp 40,987,500.,-  dan jumlah SDM pada pekerjaan yang dipercepat menjadi 

bertambah 8 %  dengan pertambahan  biaya langsung sebesar Rp  6,841,500  . Dari 

kesimpulan di atas dapat diketahui, semakin dipercepat durasi penyelesaiannya maka jumlah 

SDM yang dibutuhkan semakin meningkat 

 

Tahap-tahap penelitian secara skematis dalam bentuk bagan alir dapat dilihat pada  
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Gambar 3.1. 

 Tahap 1 

 

    

 Tahap II 

 

 

Tahap III 

 

 

                 

           Tahap IV 

       

         Tahap V 

 

         Tahap VI 

 

          Tahap VII  

 

   Gambar 3.1 Bagan alir tahap-tahap penelitian. 
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BAB 11 

LANDASAN TEORI 

2.1 UMUM 

Dalam pelaksanaan suatu proyek sangat jarang ditemui suatu proyek yang berjalan 

tepat sesuai dengan yang direncanakan, umumnya mengalami keterlambatan 

dariyang direncanakan, baik waktu maupun kemajuan pekerjaan, tetapi ada juga 

proyekyang mengalami percepatan dari jadwal awal yang direncanakan. Untuk 

menghindarikerugiaan dalam proyek, kita dapat meramalkan (forecasting) terhadap 

biayapenyelesaian dengan konsep nilai hasil (earned value analysis) (Irfanur 

Rahman,2010). 

Pengendalian biaya merupakan hal penting dalam setiap proyek konstruksi. 

Pengendalian biaya tidak hanya memonitor biaya dan mencatat data kuantitas 

saja,tetapi juga menganalisis data untuk melakukan tindakan koreksi sebelum 

terlambat.Manajemen yang efektif dari suatu program selama siklus operasi proyek 

konstruksi, memerlukan pengorganisasian biaya dan sistem pengontrolan yang baik. 

Manajemen harus membandingkan biaya, waktu dan kinerja dari program terhadap 

rencana penganggaran biaya, waktu dan kinerja secara simultan dan terintegrasi 

dalam setiap aktifitas (Herry P. Chandra, et al, 2004) 

Pemantauan dan pengendalian pelaksanaan proyek dilakukan dengan tujuan untuk  

mengetahui laju pelaksanaan pekerjaan, sehingga penyimpangan-penyimpangan 

yang terjadi dapat dengan cepat diketahui dan dapat dilakukan langkah-langkah 

penanganan yang sesuai. Dalam pelaksanaanya diperlukan teknik-teknik, metode dan  

bahkan alat bantu yang dapat mempermudah dalam pelaksanaannya baik berupa 

tabel, grafik ataupun program aplikasi. Alat bantu yang dipergunakan dalam  

pelaksanaan pemantauan dan pengendalian pelaksanaan proyek konstruksi harus  
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mudah dipergunakan, mudah dibaca dan aplikatif (Tridjoko Sri Margianto & Heri  

Suprapto, 2006). 

Berdasarkan survei dinyatakan bahwa Microsoft Project merupakan suatu alat bantu  

atau tools yang menduduki peringkat pertama sebagai alat bantu dalam mendukung  

manajemen proyek. Hal ini merupakan implikasi dari kehandalan software aplikasi  

tersebut menangani manajemen proyek (Catur Bawa, 2007). 

Konsep “earned value” merupakan salah satu alat yang digunakan dalam 

pengelolaan proyek yang mengintegrasikan biaya dan waktu. Konsep earned value 

menyajikan tiga dimensi yaitu penyelesaian fisik dari proyek (the percent complete) 

yang mencerminkan rencana penyerapan biaya (budgeted cost), biaya aktual yang 

sudah dikeluarkan atau yang disebut dengan actual cost serta apa yang yang 

didapatkan dari biaya yang sudah dikeluarkan atau yang disebut earned value. Dari 

ketiga dimensi tersebut, dengan konsep earned value, dapat dihubungkan antara 

kinerja biaya dengan waktu yang berasal dari perhitungan varian dari biaya dan 

waktu (Flemming dan Koppelman, 1994 dalam makalah Biemo W. Sumardi et al 

2.2. Dasar Teori   

Proyek adalah suatu kegiatan yang dilakukan untuk mencapai tujuan dan sasaran  

tertentu, yang dalam prosesnya dibatasi oleh waktu  dan sumber daya yang 

diperlukan dan persyaratan-persyaratan tertentu lainnya.   Menurut Iman Soeharto 

(1995), di dalam proses mencapai tujuan tersebut telah ditentukan batasan yaitu 

besar biaya (anggaran) yang dialokasikan, dan jadwal serta mutu yang harus 

dipenuhi. Ketiga batasan di atas disebut tiga kendala (triple constraint). Seperti 

diperlihatkan oleh Gambar 2.1 ini merupakan parameter penting bagi 

penyelenggaran proyek yang sering diasosiasikan sebagai sasaran proyek.  
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a. Anggaran  

Proyek harus diselesaikan dengan biaya yang tidak melebihi anggaran.  Untuk 

proyek-proyek yang melibatkan dana dalam jumlah besar dan jadwal bertahun  

tahun, anggarannya bukan hanya ditentukan untuk total proyek, tetapi dipecah bagi 

komponen-komponennya atau per periode tertentu (misalnya per kuartil) yang  

jumlahnya disesuaikan dengan keperluan. Dengan demikian, penyelesaian bagian-

bagian proyekpun harus memenuhi sasaran anggaran per periode.  

b. Jadwal  

Proyek harus dikerjakan sesuai dengan kurun waktu dan tanggal akhir yang telah 

ditentukan. Bila hasil akhir adalah produk baru, maka penyerahannya tidak boleh 

melebihi batas waktu yang telah ditentukan.  

c. Mutu  

Produk atau hasil kegiatan proyek harus memenuhi spesifikasi dan kriteria yang 

dipersyaratkan. Jadi, memenuhi persyaratan mutu berarti mampu memenuhi  

tugas yang dimaksudkan atau sering disebut sebagai fit for intended use 

 

Biaya 

Anggaran 

 

 

 

Jadwal                                     Mutu 

Waktu                                   Kinerja 

Gambar 2.1 Sasaran proyek yang juga merupakan tiga kendala (triple constraint)  

Sumber : manajemen proyek dari konseptual sampai operasional, (imam soeharto) 
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Dalam manajemen proyek ada tiga fungsi dasar manajemen yang saling terkait yaitu: 

perencanaan, pelaksanaan dan pengendalian. Setiap fungsi merupakan tahap yang 

harus dipenuhi, jadi tidak mungkin salah satu fungsi tersebut ditinggalkan. 

Pengelolaan proyek akan berhasil baik jika semua fungsi manajemen dijalankan  

secara efektif. 

2.3    Perencanaan Proyek     

Perencanaan merupakan peramalan masa yang akan datang dan perumusan kegiatan 

kegiatan yang akan dialaksanakan untuk mencapai tujuan yang telah ditetapkan.  

Bentuk dari perencanaan dapat berupa: perencanaan prosedur, perencanaan metode  

kerja, perencanaan standar pengukuran hasil, perencanaan anggaran biaya,  

perencanaan program (rencana kegiatan beserta jadwal). 

2.4.  Penjadwalan Proyek   

Jadwal waktu proyek merupakan alat yang dapat menunjukkan kapan 

berlangsungnya  

setiap kegiatan, sehingga dapat digunakan pada waktu merencanakan kegiatan 

kegiatan maupun untuk pengendalian pelaksanaan proyek secara keseluruhan. 

Jadwal  

pelaksanaan proyek berguna untuk menentukan waktu dan urutan kegiatanproyek 

dan dibuat berdasarkan daftar perincian pekerjaan. Rencana kerja dan jadwal waktu 

proyek merupakan tulang punggung keseluruhan proses konstruksi, sehingga harus 

dibuat berdasarkan pada sasaran dan pencapaian target yang jelas dengan memakai 

jadwal rencana kerja yang tepat sumber daya yang memadai dapat tersedia pada saat 

yang tepat, setiap tahap proses mendapatkan alokasi waktu cukup dengan berbagai 

kegiatan dapat dimulai pada saat yang tepat pula. Dalam menyusun jadwal rencana 
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kerja harus sudah mempertimbangkan dan mencakup : 1.estimasi kebutuhan sumber 

daya dan dana disertai dengan analisis penggunaannya yang paling mangkus, dan 2. 

menentukan rambu-rambu pengukuran target kemajuan proyek (Istimawan 

Dipohusodo, 1996) 

2.5. Pelaksanaan Proyek   

Melaksanakan suatu proyek adalah proses merubah masukan-masukan yang berupa  

kegiatan dan sumber daya menjadi keluaran seperti yang sudah ditentukan di dalam  

kerangka logis. Perencanaan masukan-masukan yang diperlukan secara rinci akan  

sangat menentukan kelancaran pelaksanaan proyek. Banyak terjadi kelambatan 

dalam pelaksanaan, pembiayaan melampaui batas anggaran dan masalah-masalah 

lainnya timbul oleh karena tim proyek tidak berhasil menyiapkan perencanaan 

masukan secara cukup terinci sedemikian sehingga seluruh kegiatan proyek dapat 

dijadwalkan, dianggarkan, dimonitoring dan dikendalikan 

2.6 Pengendalian Proyek   

Pengendalian adalah usaha yang sistematis untuk menentukan standar yang sesuai  

dengan sasaran perencanaan, merancang sistem, membandingkan pelaksanaan 

dengan standar menganalisis kemungkinan adanya penyimpangan antara 

pelaksanaan dan standart, kemudian mengambil tindakan pembetulan yang 

diperlukan agar sumber daya digunakan secara efektif dan efisien dalam rangka 

mencapai sasaran (Iman Soeharto, 1995).   

2.6.1  Pengendalian Waktu dan Biaya   

Tugas pokok yang pertama kali dalam pelaksanaan pengendalian waktu dan biaya  

adalah merencanakan dan menganalisis proyek dalam bentuk struktur perincian  

kegiatan dan anggaran. Kemudian dikembangkan darinya jadwal rencana kerja 

utama yang dilengkapi dengan rambu-rambu marka atau titik kontrol dan jadwal 
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rencana anggaran pembiayaan. Keduanya merupakan alat pokok untuk 

mengendalikan faktor faktor waktu dan biaya dari kinerja proyek 

2.7 Konsep Nilai Hasil   

Konsep nilai hasil adalah konsep menghitung besarnya biaya yang menurut anggaran  

sesuai dengan pekerjaan yang telah diselesaikan atau dilaksanakan (Budgeted Cost of  

Work Performed). Bila ditinjau dari jumlah pekerjaan yang diselesaikan, maka  

konsep ini mengukur besarnya unit pekerjaan yang telah diselesaikan pada suatu 

waktu bila dinilai berdasarkan jumlah anggaran yang disediakan untuk pekerjaan  

tersebut. Dengan perhitungan ini diketahui hubungan antara apa yang sesungguhnya 

telah dicapai secara fisik terhadap anggaran yang telah dikeluarkan (Iman 

Soeharto,2001).   

Nilai hasil dirumuskan sebagai berikut:   

Nilai hasil = (% penyelesaian) x (Anggaran)    

 

2.7.1 Indikator-indikator Konsep Nilai Hasil   

Penilaian kinerja proyek dengan konsep nilai hasil dilakukan dengan menggunakan  

indikator-indikator sebagai berikut:   

a. BCWS (Budgeted Cost for Work Schedule)  

BCWS merupakan anggaran biaya yang telah direncanakan berdasarkan jadwal  

pelaksanaan proyek. Untuk setiap periode yang diinginkan, anggaran biaya pada  

jadwal pekerjaan dihitung pada level cost account dengan menjumlahkan seluruh  

anggaran paket pekerjaan.  

b. BCWP (Budgeted Cost for Work Performance) 

BCWP menunjukkan nilai hasil dari sudut pandang nilai pekerjaan yang telah  

diselesaikan terhadap anggaran yang disediakan untuk melaksanakan pekerjaan  
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tersebut. Bila angka ACWP dibandingkan dengan BCWP, akan terlihat  

perbandingan antara biaya yang telah dikeluarkan untuk pekerjaan yang telah  

terlaksana terhadap biaya yang seharusnya dikeluarkan untuk maksud tersebut.  

c. ACWP (Actual Cost of Work Performance)  

ACWP adalah biaya aktual yang dikeluarkan untuk penyelesaian pekerjaan pada 

periode waktu yang bersangkutan. Biaya aktual didapat dari laporan-laporan dan 

dikumpulkan pada level cost account periode itu.  Indikator-indikator konsep nilai 

hasil ini kemudian dapat dibuat grafik berbentuk huruf “S”, sehingga akan segera 

terlihat jika terjadi penyimpangan. 

2.8 Analisa Kinerja Proyek 

2.8.1 Varians biaya dan jadwal tepadu  

Metode nilai hasil dengan indikator BCWS, ACWP dan BCWP akan menghasilkan  

varians biaya terpadu (cost variance) dan varians jadwal terpadu (schedule variance).  

Varians  biaya (CV) merupakan selisih antara nilai yang diperoleh setelah  

menyelesaikan paket-paket pekerjaan dengan biaya aktual yang terjadi selama  

pelaksanaan proyek. Sedangkan varians jadwal (SV) digunakan untuk menghitung  

penyimpangan antara BCWS dengan BCWP. Analisis varians terpadu dapat dilihat  

pada tabel 2.1 sedangkan rumus varians biaya dan varians jadwal sebagai berikut:  

Varians biaya (CV) = BCWP-ACWP      

Varians jadwal (SV) = BCWP-BCWS      

Pekerjaan terlaksana lebih cepat daripada jadwal dengan biaya lebih kecil daripada 

anggaran Pekerjaan terlaksana tepat sesuai jadwal dengan biaya lebih rendah 

daripada anggaran Pekerjaan terlaksana sesuai anggaran dan selesai lebih cepat 

daripada jadwal Pekerjaan terlaksana sesuai jadwal dan anggaran Pekerjaan selesai 

terlambat dan menelan biaya lebih tinggi daripada anggaran Pekerjaan terlaksana 
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sesuai jadwal dengan menelan biaya di atas anggaran Pekerjaan selesai terlambat dan 

menelan biaya sesuai anggaran Pekerjaan selesai lebih cepat daripada rencana 

dengan menelan biaya di atas anggaran  

Sumber : Iman Soeharto, 1995   

2.8.2  Indeks poduktivitas dan kinerja  

Indeks poduktivitas dan kinerja menyatakan efisiensi penggunaaan sumber daya.  

Adapun rumus yang digunakan sebagai berikut:  

Indeks kinerja biaya (CPI) = BCWP/ACWP   

Jika, CPI  =1, biaya sesuai anggaran  

   >1, biaya proyek lebih kecil  

   <1, b iaya proyek lebih besar  

Indeks kinerja jadwal (SPI) = BCWP/BCWS   

Jika, SPI =1, proyek tepat waktu  

  >1, proyek lebih cepat  

  <1, proyek terlambat   

2.8.3. Proyeksi biaya dan jadwal akhir proyek  

Membuat prakiraan biaya atau jadwal penyelesaian proyek yang didasarkan atas  

hasil analisis indikator yang diperoleh pada saat pelaporan, akan memberikan  

petunjuk besarnya biaya pada akhir proyek (estimate at completion-EAC).  

Prakiraan tidak tidak dapat memberikan jawaban dengan angka yang tepat karena  

didasarkan atas berbagai asumsi, jadi, tergantung dari akurasi asumsi yang  

dipakai. Meskipun demikian, pembuatan prakiraan biaya atau jadwal amat  

bermanfaat karena memberikan peringatan dini mengenai hal-hal yang akan  

terjadi pada masa yang akan datang, bila kecenderungan yang ada pada saat ini  

(saat pelaporan) tidak mengalami perubahan. Dengan demikian, masih tersedia  
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kesempatan untuk mengadakan tindakan pembetulan.   

Bila kinerja biaya pada pekerjaan tersisa dianggap tetap seperti pada saat  

pelaporan maka prakiaan biaya untuk pekerjaan tersisa (ETC) adalah sama besar  

dengan anggaran pekerjaan tersisa dibagi indeks kinerja biaya. Sedangkan  

prakiraan waktu untuk pekerjaan tersisa (ETS) adalah besarnya sisa waktu  

pekerjaan dibagi indeks kinerja jadwal.   

ETC = (BAC – BCWP)/CPI    (Rumus 2.6)  

ETS = sisa waktu/SPI     (Rumus 2.7)   

Prakiraan total biaya (EAC) adalah sama dengan jumlah pengeluaran sampai  

pada saat pelaporan ditambah prakiraan biaya untuk pekerjaan tersisa. Sedangkan  

prakiraan waktu penyelesaian pekerjaan seluruh pekerjaan (EAS) adalah  

besarnya waktu penyelesaian pekerjaan dalam jadwal ditambah dengan prakiraan  

waktu untuk pekerjaan tersisa.   

EAC = ACWP + ETC      

EAS = waktu selesai + ETS 

2.9  Manajemen Proyek 

Project manajemen intitute (pmi) mendefenisikan istilah manajemen proyek sebagai 

sebuah aplikasi dari p-engetahuan, keahlian, alat, dan pada aktivitas proyek tertentu 

untuk memenuhi syarat berlangsung nya sbuah proyek dengan kata lain 

menyelesaikan pekerjaan tepat waaktu daalam budget dan sesuai persyaratan atau 

spesifikasi. Unsur pembatas waktu, budget dan spesifakasi sering disebut triple 

constrant Hal terpenting dalam mengelola sebuah proyek adalah siklus hidup proyek. 

Siklus hidup proyek yang dimaksud adalah rentan waktu yang terdiri dari tahapan-

tahapan yang akan dilalui sebuah proyek. Siklus hidup proyek memiliki empat 
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tahapan yang harus dilalui, yaitu; Inisiasi proyek, Perencanaan proyek Pengendalian 

proyek selama pelaksanaan Penutupan proyek  

2.9.1 Tahap inisiasi proyek 

Fokus utama tahapan inisiasi proyek adalah menemukan tantangan dan masalah 

dalam proyek. Sedangkan, tujuan dari tahap inisiasi adalah identifikasi terhadap 

segala hal yang harus dilakukan dan hambatan-hambatan  yang mungkin terjadi 

selama proses pengerjaan, secara teknis tahap ini adalah tahap pemilihan manjer 

proyek yang akan kita jalankan  

 

2.9.2 Definisi Dan Aspek-Aspek dalam Manajemen Proyek 

Suatu ilmu pengetahuan tentang seni memimpin organisasi yang terdiri atas kegiatan 

perencanaan pengorganisasian, pelaksanaan dan pengendalian terhadap sumber-

sumber daya yang terbatas dalam usaha mencapai tujuan dan sasaran yang efektif 

dan efisien. 

a. Tujuan Manajemen: 

Mendapatkan metode atau cara teknis yang paling baik agar dengan sumber-sumber 

daya yang terbatas diperoleh hasil maksimal dalam hal ketepatan, kecepatan, 

penghematan dan keselamatan kerja secara komprehensif. 

b. Unsur-unsur Manajemen 

Tujuan: sasaran yang hendak dicapai dalam optimasi biaya, mutu, waktu dan 

keselamatan Pemimpin: mengarahkan organisasi dalam mencapai sasaran dan 

tujuan. Sumber-sumber daya yang terbatas: manusia, modal/biaya, peralatan dan 

materialKegiatan: Perencanaan, Pengorganisasian, Pelaksanaan dan Pengendalian 

Perencanaan (Planning) 
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Pada kegiatan ini dilakukan antisipasi tugas dan kondisi yang ada dengan 

menetapkan sasaran dan tujuan yang harus dicapai serta menentukan kebijakan 

pelaksanaan, program yang akan dilakukan, jadwal waktu pelaksanaan, prosedur 

pelaksanaan secara administratif dan operasional serta alokasi anggaran biaya dan 

sumber daya. 

Perencanaan harus dibuat dengan cerrnat, lengkap, terpadu dan dengan tingkat 

kesalahan paling minimal. Namun hasil dari perencanaan bukanlah dokumen yang 

bebas dari koreksi karena sebagai acuan bagi tahapan pelaksanaan dan pengendalian, 

perencanaan harus terus disempurnakan secara iteratif untuk menyesuaikan dengan 

perubahan dan perkembangan yang terjadi pada proses selanjutnya. 

c. Pengorganisasian ( Organizing) 

Pada kegiatan ini dilakukan identifikasi dan pengelompokan jenis-jenis pekerjaan, 

menentukan pendelegasian wewenang dan tanggung jawab personel serta 

meletakkan dasar bagi hubungan masing-masing unsur organisasi. Untuk 

menggerakkan organisasi, pimpinan harus mampu mengarahkan organisasi dan 

menjalin komunikasi antarpribadi dalam hierarki organisasi. Semua itu dibangkitkan 

melalui ranggung jawab dan partisipasi semua pihak. Stmktur organisasi yang sesuai 

dengan kebutuhan proyek dan kerangka penjabaran tugas personel penanggung 

jawab yang jelas, sefta kemampuan personel yang sesuai keahliannya, akan 

diperoleh hasil positif bagi organisasi. 

Pelaksan art (Acruating) Kegiatan ini adalah implementasi dari perencanaan yang 

telah ditetapkan, dengan melakukan tahapan pekerjaan yang sesungguhnya secara 

fisik atau nonfisik sehingga produk akhir sesuai dengan sasaran dan tujuan yang 

telah dirctapkan. Karena kondisi perencanaan sifatnya masih ramalan dan subyektif 

serta masih perlu penyempurnaan, dalam tahapan ini sering terjadi perubahan-
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perubahan dari rencana yang telah ditetapkanBiasanya, pada tahapan pelaksanaan, 

pihak-pihak yang terlibat lebih beragam. Oleh karena itu, dibutuhkan koordinasi 

terpadu untuk mencapai keserasian dan keseimbangan kerja. Pada tahapani ni juga 

telah ditetapkan konsep pelalsanaan sertap ersonel yang terlibat pada organisasinya, 

kemudian secara detail menetapkan jadwal, program, alokasi biaya, serta alokasi 

sumber daya yang digunakan. 

d. Pengendalian (Controlling) 

Kegiatan yang dilakukan pada tahapan ini dimaksudkan untuk memasrikan bahwa 

program dan aturan kerja yang telah ditetapkan dapat dicapai dengan penyimpangan 

paling minimal dan hasil paling memuaskan. Untuk itu dilakukan bentuk-bentuk 

kegiatan seperti berikut: o Supervisi: melakukan serangkaian tindakan koordinasi 

pengawasan dalam batas wewenang dan tanggung jawab menurut prosedur 

organisasi yang telah ditetapkan, agar dalam operasional dapat dilakukan secara 

bersama-sama oleh semua personel dengan kendali Pengawas. ' Inspeksi: melakukan 

pemeriksaan terhadap hasil pekerjaan dengan tujuan menjamin spesifikasi mutu dan 

produk sesuai dengan yang direncanakan. o Tindakan Koreksi: melakukan 

perubahan dan perbaikan terhadap rencana yang telah ditetapkan untuk 

menyesuaikan dengan kondisi pelaksanaan. Proses dalam manajemen sifatnya umum 

dan dapat digunakan dalam berbagai kegiatan/bidang yang membutuhkan 

pengelolaan yang sisrematis, terarah serta mempunyai sasaran dan tujuan yang jelas. 

Macam dan bidang yang menggunakan ilmu manajemen adalah manajemen 

pemerintahan, mana;'emen industri, manajemen perusahaan, manajemen sumber 

daya, manajemen proyek, dan lain sebagainya. untuk manajemen proyek biasanya 

kurun waktu dibatasi oleh program-program yang sifatnya sementara dan berakhir 

bila sasaran dan tujuan organisasi proyek sudah tercapai. Bila membuat proyek 
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sejenis pada waktu sesudahnya, biasanya sasaran dan tujuannya lebih inovatif 

dengan memodifikasi program-program sebelumnya. 

2.9.3 Tahapan perencanaan proyek  

Fokus utama tahapan perencanaan proyek adalah bagaiman kita bisa menyelesaikan 

ugas yang dibebankan kepada kita. Tujuan dari tahap ini adalah 

mengembangkandetail perencanaan proyek dengan melakukan breakdown setiap 

detail tugas, alokasi sumber daya , penjadwalan, perencanaan anggaran dan 

bagaimana meminimalisasi risiko. Jika rencana tersebut telah disetujui oleh 

champion, mak proposal rencana pengelolaan proyek tadi disebut proyek baseline. 

Bseline dijadikan sebagai tolak ukur pengendalian proyek  

2.9.4 Tahap pengontrolan proyek  

Fokus utama pada proyek ini adalah memastikan bahwa proyek yang kita kita 

kerjakan tetap pada jalur yang telah direncanakan pada tahap ini pengerjaan proyek 

telah dilakukan 

Tuhjuan tahapan ini adala memastikan bahwa proyek dapat berjalan sesuai dengan 

rencana dan sesuai dengan spesifikasi dan dalam batasan anggaran  

2.9.5 Tahapan penutupan proyek 

 Adatiga fokus pada tahapan ini, yaitu pertanggung jawaban, pembelajaran proyek 

dan perayaan. Setelah proyek selesai dikerjakan maka manajer proyek wajib 

mempertanggung jawabkan pengerjaan proyek pad champion dan recipien (penerima 

atau penggguna proyek)  

Biasanya champion atau pemilik proyek yang memberikan pernyataan resmi 

mengenai selesainya proyek tersebut. Maka proses evaluasi selama berlanngsungya 

proyek bagi seluruh tim merupakan proses pembelajaran yang sangat berharga. 

Untuk itu seorang manjer proyek memiliki peran yang sangat penting penyebaran 
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proses pembelajaran proyek dalam tim yang dipimpinya. Manajemen proyek adalah 

ilmu dan seni yang berkaitan dengan memimpin dan mengkoordinir sumber daya 

yang terdiri dari manusia dan material dengan menggunakan tehnik pengelolaan 

modern untuk mencapai sasaran yang telah ditentukan serta memenuhi keinginan 

para pemilik proyek (owner) 

Jadwal waktu proyek merupakan alat yang dapat menunjukkan kapan 

berlangsungnya setiap kegiatan, sehingga dapat digunakan pada waktu 

merencanakan kegiatan kegiatan maupun untuk pengendalian pelaksanaan proyek 

secara keseluruhan. Jadwal pelaksanaan proyek berguna untuk menentukan waktu 

dan urutan kegiatan-kegiatan proyek dan dibuat berdasarkan daftar perincian 

pekerjaan.  Rencana kerja dan jadwal waktu proyek merupakan tulang punggung 

keseluruhan proses konstruksi, sehingga harus dibuat berdasarkan pada sasaran dan 

pencapaian target yang jelas dengan memakai jadwal rencana kerja yang tepat 

sumber daya yang memadai dapat tersedia pada saat yang tepat, setiap tahap proses 

mendapatkan alokasi waktu cukup dengan berbagai kegiatan dapat dimulai pada saat 

yang tepat pula. Dalam menyusun jadwal rencana kerja harus sudah 

mempertimbangkan dan mencakup : 1.estimasi kebutuhan sumber daya dan dana 

disertai dengan analisis penggunaannya yang paling mangkus, dan 2. menentukan 

rambu-rambu pengukuran target kemajuan proyek (Istimawan Dipohusodo, 1996) 

 

2.10. Penjadwalan Ulang Proyek  

 Tidak semua proyek yang mengalami keterlambatan harus direschedule. 

Hanya proyek-proyek tertentu yang memiliki ciri-ciri harus direschedule yang akan 

dijadwalkan ulang. 
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 Berikut ciri-ciri proyek yang harus di reschedule. Proyek mengalami minus 

pekerjaan hingga lebih dari 10% sehingga tidak  mungkin lagi mengejar progres 

pekerjaan hingga mempunyai deviasi plus, Terjadi keterlambatan material-material 

besar yang mempunyai nilai anggaran tinggi, Progress realisasi tiap minggunya 

hanya kurang dari 1/4 progres rencana, Perubahan spesifikasi material besar dan 

desain bangunan secara mendadak.  Perubahan spesifikasi material akan berakibat 

pada kemunduran proyek  karena untuk mencari vendor baru memerlukan waktu 

yang lebih lama lagi, Terjadi kecurangan dalam manajemen proyek. Misalkan 

adanya oknum staf proyek yang menyalahgunakan anggaran proyek sehingga terjadi 

kendala dalam pembiayaan, Terjadi kekurangan tenaga kerja baik tukang maupun 

kenek dalam jumlah besar, Terjadi force major yang diluar dugaan seperti bencana 

alam, krisis ekonomi dan sebagainya, Keinginan pemilik proyek untuk 

memmpersingkat waktu pelaksanaan proyek. 

Proses reschedule ini bisa dikatakan langkah jitu untuk menyiasati keterlambatan 

progress pekerjaan. Reschedule proyek harus diimbangi dengan perubahan metode 

pelaksanaan pekerjaan agar disisa pekerjaan bisa selesai tepat waktu.  

 Faktor-Faktor Penjadwalan Ulang Proyek 

Faktor-faktor yang harus dipertimbangkan dalam membuat jadwal pelaksanaan 

proyek; Kebutuhan dan fungsi proyek tersebut. Dengan selesainya proyek dapat  

diharapkan  dimanfaatkan/digunakan sesuai dengan waktu yang sudah ditentukan, 

Keterkaitannya dengan proyek berikutnya ataupun kelanjutan dari proyek 

selanjutnya, Alasan social politis lainnya, apabila proyek tersebut milik pemerintah  

Kondisi alam dan lokasi proyek, Keterjangkauan lokasi proyek ditinjau dari fasilitas 

perhubungannya, Kapasitas atau daya tampung area kerja proyek terhadap sumber 

daya yang dipergunakan selama operasional pelaksanaan berlangsung, Produktivitas 
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sumber daya dan peralatan proyek,  selama operasional berlangsung dengan referensi 

dan perhitungan yang memenuhi aturan teknis, keadaan cuaca, musim dan gejala 

alam lainnya. 

2.11.  Biaya proyek  

Penggerak untuk menjalankan proyek adalah pembiayaan. Untuk mengetahui  

pembiayaan, perlu dibuatkan suatu anggaran proyek. Secara umum biaya konstruksi  

dibagi menjadi dua kelompok besar, yaitu: biaya langsung dan tidak langsung.  

2.11.1. Biaya Langsung (Direct Cost)  

Biaya langsung adalah seluruh biaya yang berkaitan langsung dengan fisik  

proyek, yaitu meliputi seluruh biaya dari kegiatan yang dilakukan di proyek (dari  

persiapan hingga penyelesaian) dan biaya mendatangkan seluruh sumber daya  

yang diperlukan oleh proyek tersebut.   

Biaya langsung ini dibagi menjadi lima, yaitu: Biaya bahan / material, Biaya upah 

kerja, Biaya alat, Biaya subkontraktor, Biaya lain-lain  

Biaya lain-lain biasanya relatif kecil. Tetapi bila jumlahya cukup berarti harus  

dirinci agar memudahkan untuk proses pengendalian.  

2.11.2.  Biaya Tidak Langsung (Indirect Cost)  

Biaya tidak langsung adalah seluruh biaya yang terkait secara tidak langsung,  

yang dibebankan kepada proyek. Biaya ini biasanya tejadi di luar proyek. Biaya  

ini meliputi antara lain: biaya pemasaran, biaya overhead di kantor pusat/ cabang  

(bukan overhead kantor proyek). Biaya ini tiap bulan besarnya relatif tetap  

dibanding dengan biaya langsung, oleh karena itu juga sering disebut dengan  

biaya tetap (fix cost). Biasanya pembebanan biaya tetap ini ditetapkan dalam  

persentase dari biaya langsung proyeknya. Biaya ini walaupun sifatnya tetap,  

tetapi tetap harus dilakukan pengendalian, agar tidak melewati anggarannya.   
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Inti dari perkiraan biaya secara detail adalah yang didasarkan pada penentuan jumlah  

material, tenaga kerja, peralatan dan jasa subkontraktor yang merupakan bagian  

terbesar dari biaya total proyek yaitu berkisar antara 85 % yang terdiri dari biaya  

peralatan sebesar 20-25 %, material curah 20-25 %, biaya konstruksi di lapangan  

yaitu tenaga kerja, material, jasa subkontraktor 45-50 % (Ritz, 1994 dalam skripsi  

Irfanur Rahman, 2010). 

Melaksanakan suatu proyek adalah proses merubah masukan-masukan yang berupa  

kegiatan dan sumber daya menjadi keluaran seperti yang sudah ditentukan di dalam  

kerangka logis. Perencanaan masukan-masukan yang diperlukan secara rinci akan  

sangat menentukan kelancaran pelaksanaan proyek. Banyak terjadi kelambatan 

dalam pelaksanaan, pembiayaan melampaui batas anggaran dan masalah-masalah 

lainnya timbul oleh karena tim proyek tidak berhasil menyiapkan perencanaan 

masukan secara cukup terinci sedemikian sehingga seluruh kegiatan proyek dapat 

dijadwalkan, dianggarkan, dimonitoring dan dikendalikan.   

2.12.  Microsoft Project 2007 

Pendekatan yang lazim digunakan dalam penjadwalan proyek ulang adalah:  

Microsoft project Pengertian microsoft project 2007 (MSP atau Winproj) adalah 

suatu manajemen proyek perangkat lunak program yang dikembangkan dan dijual 

oleh microsoft yang dirancang untuk membantu manajer proyek dalam 

mengembangkan rencana, menetapkan sumber daya untuk tugas-tugas pelacakan 

kemajuan, pengelola anggaran dan menganalisis beban kerja. Microsoft Project 2007 

adalah sebuah aplikasi untuk mengelola suatu proyek. Microsoft project merupakan 

sistem perencanaaan yang dapat membantu dalam menyusun penjadwalan 

(scheduling) suatu proyek atau rangkaian pekerjaan. Microsoft project juga mampu 

membantu melakukan pencatatan dan pemantauan terhadap penggunaan sumber 
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daya (resource), baik yang berupa sumber daya manusia maupun yang berupa 

peralatan. Yang dikerjakan oleh microsoft project antara lain: mencatat kebutuhan 

tenaga kerja pada setiap sektor, mencatat jam kerja para pegawai, jam lembur dan 

menghitung pengeluaran sehubungan dengan ongko tenaga kerja, memasukkan biaya 

tetap, menghitung total biaya proyek, serta membantu mengontrol penggunaan 

tenaga kerja pada beberapa pekerjaan untuk menghindari overallocation (kelebihan 

beban pada penggunaan tanga kerja) (Adi Kusrianto, 2008).  Microsoft Project 2007 

memiliki beberapa macam tampilan layar, namun sebagai default setiap kali 

membuka file baru, yang akan ditampilkan adalah Gant Chart View. 

 

Gambar 2.2: Tampilan microsoft project (sumber: program microsoft project) 
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Dalam Microsoft Project ada beberapa istilah khusus, antara lain:  

a. Gantt Chart 

Gantt Chart adalah sejenis grafik batang (Bar Chart) yang digunakan 

untukmenunjukan Tugas-tugas pada Proyek serta Jadwal dan waktu pelaksanaannya, 

seperti waktu dimulainya tugas tersebut dan juga batas waktu yang digunakan untuk 

menyelesaikan tugas yang bersangkutan. Orang atau Departemen yang ditugaskan 

untuk menyelesaikan Tugas dalam proyek juga harus dituliskan dalam 

GanttChart.Beberapa sebutan lain untuk Gantt Chart diantaranya adalah Milestones 

Chart, Project Bar Chart dan juga activity chart. Gantt Chart yang dikembangkan 

oleh Henry Laurence Gantt pada tahun 1910 ini pada dasarnya adalah suatu 

gambaran atas perencanan, penjadwalan dan pemantauan (monitoring) kemajuan 

setiap kegiatan atau aktivitas pada suatu proyek. Gantt Chart merupakan salah satu 

alat yang sangat bermanfaat dalam merencanakan penjadwalan dan memantau 

kegiatan pada suatu proyek,  mengkomunikasikan kegiatan-kegiatan yang harus 

dilaksanakan dan juga status pelaksanaannya. Dalam Gantt Chart juga dapat dilihat 

urutan kegiatan ataupun tugas yang harus dilakukan berdasarkan prioritas waktu 

yang ditentukan Cara Membuat Gantt Chart merupakan grafik yang sederhana, Cara 

membuatnya juga cukup mudah. Berikut ini adalah langkah-langkah dalam membuat 

Gantt Chart serta cara penggunaannya Mengidentifikasikan Tugas 

Mengidentifikasikan Tugas yang perlu diselesaikan pada ProyekMenentukan 

Milestone (bagian pekerjaan dari suatu tugas) dengan menggunakan Brainstorming 

ataupun Flow chart.Mengidentifikasikan waktu yang diperlukan dalam 

menyelesaikan suatu tugas. Mengidentifikasikan urutan pekerjaan ataupun tugas 

yang akan dikerjakan. Seperti Tugas yang harus diselesaikan sebelum memulai suatu 

tugas yang baru ataupun tugas-tugas apa yang harus dilakukan secara bersamaan 
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(Simultan). Menggambarkan Sumbu Horizontal Gambarkan sumbu horizontal untuk 

waktu pelaksanaannya (dapat diletakan diatas atau dibawah halaman).  Tandai 

dengan skala waktu yang sesuai (bisa dalam harian maupun mingguan).  Menuliskan 

Tugas ataupun Bagian Pekerjaan Tuliskan Tugas atau bagian pekerjaan (milestone) 

yang akan dikerjakan berdasarkan urutan waktu pada bagian kiri. Gambarkan 

Diagram Batang (Bar Graph) untuk menunjukan rentang waktu yang diperlukan 

untuk melakukan tugas yang bersangkutan. Gambarkan kotak dari kiri dimana waktu 

Tugas tersebut dimulai sampai pada waktu tugas yang bersangkutan berakhir. Jika 

diperlukan presentasi kepada Manajemen perusahaan, gambarkan bentuk Intan 

(Diamond) pada tanggalnya. Gambarkan tepinya saja dan kotak tersebut jangan diisi. 

Melakukan Pemeriksaan kembaliLakukan pemeriksaan kembali, apakah semua tugas 

atau bagian pekerjaan untuk Proyek tersebut sudah tertulis semuanya ke dalam Gantt 

Chart.  

b. Duration  

Duration merupakan jangka waktu yang diperlukan untuk menyelesaikan suatu  

pekerjaan.  

c. Start  

Start merupakan nilai tanggal dimulainya suatu pekerjaan.  

d Finish  

Dalam Microsoft Project tanggal akhir pekerjaan disebut finish, yang akan diisi  

secara otomatis dari perhitungan tanggal mulai (start) ditambah lama pekerjaan  

(duration)  

e. Predecessor  

Predecessor merupakan hubungan keterkaitan antara satu pekerjaan dengan  

pekerjaan lain. Dalam Microsoft Project mengenal 4 macam hubungan antar  
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pekerjaan, yaitu:  

1. FS (Finish to Start)  

 Suatu pekerjaan baru boleh dimulai jika pekerjaan yang lain selesai.  

       

 

Gambar. 2.3 finish to start (sumber : tampilan program msp 2007)  

2. FF (Finish To Finish)  

 Suatu pekerjaan harus selesai bersamaan dengan selesainya pekerjaan lain.     

 

 

  

Gambar. 2.4 finish to finish (sumber : tampilan program msp 2007) 

3. SS (Start to Start)  

 Suatu pekerjaan harus simulai bersamaan dengan pekerjaan lain.  

         

 

 

Gambar. 2.5 start to start (sumber : tampilan program msp 2007)  

 4. SF (Start to Finish)  

 Suatu pekerjaan baru boleh diakhiri jika pekerjaan lain dimulai.    

 

 

 

Gambar. 2.6 start to finish (sumber : tampilan program msp 2007)  

f. Resources  
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Sumber day a, baik sumber daya manusia maupun material dalam Microsoft Project 

disebut dengan resources. Pada kotak resurces atau sumber daya ada tiga tipe jenis 

sumber daya work (tenega kerja/alat) yang termasuk dalam kelompok ini adalah 

tenaga kerja, sewa peralatan atau lat pendukung lain yang hanya di pakai sementara 

dan tidak berkurang kulitasnya akibat diperguanakan.Material yang termasuk dalam 

type ini adalahbahan baku atau material lain yang di perguanakan atau memproduksi 

sesuatu, dala hal ini seperti semen, paku, bata, pasir, batu, besi dan lain-lain. 

Cost (biaya) yang masuk pada tipe biaya adalah pengeluaran yang tidak bergantung 

pada kepada jumlah pekerjaan aatu waktu yang diperlukan seperti biaya tiket dan 

biaya lain-lain 

g. Baseline  

Baseline adalah suatu rencana baik jadwal maupun biaya yang telah disetujui dan  

ditetapkan.  

h. task 

Salah satu bentuk lembar kerja dalam microsoft project yang berisi rincian sebuah 

proyek.  

i. Tracking  

Tracking adalah mengisikan data yang terdapat di lapangan pada perencanaan  

yang telah dibuat. 
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BAB III 

METODOLOGI PENELITIAN 

3.1 Metode Penelitian. 

Metode yang digunakan dalam penelitian ini adalah metode analisis deskriptif, yaitu  

metode untuk memecahkan suatu masalah yang ada dengan cara mengumpulkandata,  

disusun, dijelaskan, diolah dan dianalisis sehingga diperoleh hasil akhir. Hasil akhir  

ini kemudian digunakan sebagai bahan untuk mengambil kesimpulan dari  

pemasalahan yang ada. Pada penelitian ini, konsep nilai hasil digunakan sebagai  

metode pengendalian biaya dan jadwal yang memperhatikan kinerja proyek. Adapun  

analisis konsep nilai hasil ini dilakukan dengan bantuan program Microsoft Project  

2007 

3.2 Pengumpulan Data 

Data dalam penelitian ini diperoleh dari pihak pengawas dan manageer proyek 

perumahan Sei Suka Residence Data tersebut meliputi:   

3.2.1 data primer 

Data primer sebagai berikut:  Rencana Anggaran Biaya (RAB), Daftar harga satuan 

bahan, alat dan upah tenaga kerja, Time schedule atau kurva S, Laporan mingguan 

yang berisi kemajuan proyek, Daftar penggunaan bahan, alat dan tenaga kerja per 1 

Unit rumah 

3.2.2 Data Sekunder  

Data sekunder dari proyek sisuka residence adalah: sumber daya (sdm) /tenaga kerja, 

data pengadaan atau kebutuhan material di lapangan 

data-data proyek 

Lokasi Proyek      : Desa Sei suka Kec.Seisuka Kab Batubara 

Jenis Proyek        : Proyek Pembanguan Perumahan 
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Waktu Proyek      : Start Agustus 2016 S/D Selesai 

Pemilik Proyek    : PT. Kharisma Abadi Mega Indah (KAMI) 

3.3 Analisis Data 

Analisis data dilakukan dengan bantuan program Microsoft Project 2007. Dengan  

menginputkan data yang terkait untuk analisis ke dalam program, maka microsoft  

project ini nantinya akan melakukan kalkulasi secara otomatis sesuai dengan rumus 

rumus kalkulasi yang telah dibuat oleh program ini. Hasil akhir yang hendak 

diperoleh pada tahap ini adalah besarnya BCWS, BCWP dan ACWP, sehingga akan  

diketahui apakah terjadi penyimpangan atau tidak. Selain itu juga akan memperoleh  

besarnya prakiraan total biaya dan waktu untuk penyelesaian proyek. Proses 

menginputkan data untuk menganalisis konsep nilai hasil meliputi dua tahap, yaitu:  

Menyusun rencana jadwal dan biaya proyek (baseline),  Aktualisasi di lapangan 

(tracking) 

3.3.1 Menyusun Rencana Jadwal dan Biaya Proyek (Baseline) 

Langkah-langkah yang dilakukan untuk menyusun rencana jadwal dan biaya proyek  

pada Microsoft Project 2007 sebagai berikut:  

1.  Membuka lembar kerja baru  

 Klik tombol Start > Program > Microsoft Office > Micosoft Office Project 

 2007.   

2.  Memasukkan tanggal dimulainya proyek  

 Klik menu Project > Project Information. Pada kotak dialog Project  

 Information dipilih Schedule From: Project Start Date dan memasukkan  

 tanggal dimulainya proyek pada kotak Start Date.  

3.  Memasukkan data kegiatan proyek dengan mengetikkannya pada kolom Task  

 Name dan waktu kegiatan pada kolom Durasi.   
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4.  Membuat hubungan antara pekerjaan satu dengan lainnya pada kolom  

 Predecessor. Hubungan antar pekerjaan dibuat berdasarkan gambar kerja (shop  

 drawing).  

5.  Menyusun kalender kerja untuk menentukan hari kerja dan jam kerja.  

 Klik menu Tools > Change Working Time > Work Weeks > Details.   

6.  Memasukkan biaya untuk tiap pekerjaan  

 Klik menu View > Table > Cost > mengisi total biaya pada kolom Fixed Cost.  

7.  Menyimpan rencana jadwal dan biaya sebagai baseline.   

 Klik menu Tools > Tracking > Set baseline > Entire Project > OK. 

3.3.2. Aktualisasi di Lapangan (Tracking)    

Langkah-langkah yang dilakukan untuk memasukkan data pelaksanaan di lapangan  

pada Microsoft Project 2007 sebagai berikut:  

1.  Memasukkan tanggal update yang dilakukan tiap minggunya dengan cara pilih  

 menu Project > Project information. Kemudian mengisikan tanggal peninjauan  

 pada kolom Current date.  

1.  Membagi layar menjadi dua (atas dan bawah) untuk memasukkan data 

aktual di  

 lapangan. Layar atas berupa Gantt Chart View dan layar bawah dengan Task  

 Usage, lalu klik View > Table:Tracking.  

3.  Menambahkan baris pada bagian kanan Task Usage dengan menekan mouse  

 kanan, pilih Detail Styles. Masukkan Actual Work <Show>, Actual Overtime  

      Work <Show>, Actual Cost <Show>, OK. 

4.    Melakukan proses updating.  

 a. Menyusun lembar sumber daya dengan meng-klik Resources Sheet pada  

     View Bar. Kemudian mengisikan jenis sumber daya termasuk harga per  
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      satuan sumber daya per hari untuk tenaga kerja dan per satuan untuk  

    material pada kolom Std Rate.  Untuk upah lembur tenaga kerja per jamnya  

    diisikan pada kolom Ovt. Rate.  

 b. Menugaskan resources untuk masing-masing sub task.  

     Meletakkan pointer pada sub task yang akan diisi resourcesnya. Klik dua  

     kali. Pada Task Information kemudian dipilih resources-nya.  

 c. Mengisikan jumlah sumber daya pada baris Actual Work.  

 d. Mengisikan persentase penyelesaian pekerjaan   

5.  Memasukkan biaya tak langsung proyek  

 Memasukkan biaya tak langsung pada Resources Sheet dan menugaskannya pada  

 summary task Proyek perumahan sei suka residence  

  Kemudian mengisi  Act. Work pada Task Usage.  

6.  Melihat indikator konsep nilai hasil   

 Pada tampilan Gantt Chart View, pilih menu View > Table > More Tables >  

 Earned Value. 
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